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Introduction 
 
 
Product Description 
 
 

Compass enables you to quickly and simply search for spare parts. The system software 
is found on your Compass CD’s and is available for use under license from FG Wilson. All 
aftermarket parts information is available at a glance with illustration and part numbers laid 
out side by side.  

 

 

System Requirements 
 
 

Minimum Requirements 
 

• Windows 2000 / XP  

• Processor - 1.8 GHz or equivalent 

• Main memory at least 512 MB 

• DVD-ROM drive 

• More than 6 GB of free memory on hard drive 

• Screen resolution 1024 x 768 or greater (800 x 600 possible, but not recommended) 
 
 

Recommended Requirements 
 

• Windows 2000 / XP  

• Processor - 3.0 GHz or faster 

• Main memory at least 1 GB 

• DVD ROM drive 

• More than 8 GB of free memory on hard drive 

• Screen resolution 1024 x 768 or greater (800 x 600 possible, but not recommended) 
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Getting Started 
 
 
Starting the Disc 
 
 

Insert the disc into your computer. The software will automatically start the installation 
process and a screen will appear: 
 

 

 
 
 
 
From this screen you can select the language for the installation process and application 
software, there are currently six language options (English, French, German, Italian, 
Spanish and Portuguese). Once you have selected a language you have three options: 
 

Exit When you select this option you will come out of the software 

without proceeding any further. 
 

Start Installation If you select this option you will start the process for a full 

installation of the software onto you PC. (Recommended) 
 

Start Install of Acrobat This option will automatically run the installation of the Adobe 

Acrobat software from the disc without installing any of the 
other software. 
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Start Installation 
 

Upon selection of the “Start Installation” option a new window will appear 

 

 
It is recommended that you exit from all windows programs before continuing with the 
installation. Once ready ‘click’ on “Next >” to continue. 

 

 
 

The new screen details the licence agreement with FG Wilson for the software. Select “I 
agree” to continue the installation. 
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This screen allows you to select the default language that the software will use to open. 
Select “Next >” to continue. 
 
 

 
 
This screen details where the software files will be installed to. It is possible to select 
“Browse” and define a new location for the software, but we recommend that you leave 
the default setting as standard. Select “Next >” to continue. 
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This screen details the type of installation you will be running. The default is a full 
installation of all the information. This will require at least 5GB of free space on your PC’s 
hard drive. If you do not have Adobe Acrobat installed onto your PC there is also the 
option to install version 6.0, at this point, by clicking on the selection box at the bottom of 
the screen. The software will work with all versions of Adobe Acrobat, but it is 
recommended that you upgrade if you are using an older version than 6.0 of the software. 
Select “Next >” to continue. 
 

 
 
 
This screen lists the options you have selected in the previous five screens. If you wish to 
change any of your selections you can click on “< Previous”. If the selections are OK then 
click on “Next >” to continue. 
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The software now makes a quick check of your system to confirm if there is enough space 
on your hard drive or if there are any previous versions of the software on the PC. Select 
“Start” to start the installation. 
 

 
 
As the installation starts, this screen appears detailing what is being installed and how far 
through the process the software has completed. The software can take up to an hour to 
install depending on the specification of your PC.  
 
If you wish to stop the installation for any reason then you can click on “Abort” at any time. 
If you do abort you will have to start the installation from the beginning.  You may want to 
remove the files that have already been loaded before restarting, although the system will 
automatically put the new install over the top of them. 
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The software has now completed installation. You can start the software immediately by 
selecting the tick box, leave it unchecked if you wish to start later, and then select “Exit” to 
finish. 
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Navigation 
 
 
Into the Catalogue 
 
 

When opening the application you will see the opening search screen: 
 

 
There are three different ways of entering the main catalogue from this search screen: 

 

Serial Number Allows you to search using a full or partial serial number to find 

the correct parts list. 
 

Model Number Allows you to search using a structured table of contents to drill 

down through all the data levels available. 
 

Part Search Allows you to search using a part number or a part description. 
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 Parts Search 
There are three main options within the parts search: search using a part number, using a 
description or using a combination of both of these. Enter the known part number or 
description and select start search; the results will be displayed below. If you do not have 
a complete number you can search by using wildcards (the ? symbol represents a single 
character and the * symbol represents multiple characters).  

 

 
Compass will list the search results in the window. The list will show every appearance of 
the specified part. To expand the selection click the small “+” symbol next to the part 
number you have searched for. The system will expand the selection and reveal all the 
build lists where the part number is used. You then have the ability to drill further down 
through the build list to display the exact location of the part you are looking for. You may 
select any of the levels, and then click on “OK” to open the catalogue at that exact point. 
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Model Number 
 

This search is a simple table of contents that can be drilled through to the desired build 
list. Once you have selected the required part number either double click on it or click on 
“OK”. 
 

 
Once the desired part number is selected then simply hit the “OK” button and a screen like 
the following one will appear.  This screen is the “catalogue of parts” screen and we will 
cover this in parts catalogue section. 
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Serial Number 
 
The serial number search has the ability to search via a number of different attributes.  
These include genset serial number, sales order number, engine serial number and 
alternator serial number.  For examples of these part numbers check the reference section 
at the rear of the book.  The system will allow you to search for an entire number or part of 
that number by including wildcards (? for a single character and * for multiple characters).  
Wildcards can be used when we only know part of the number for example if we knew the 
first 5 digits of the engine serial number was 04UG2 but were unsure of the last four digits 
we could enter 04UG2*, this would bring up the possible engine serial numbers. Once 
your serial number has been found, click “OK” to launch the parts catalogue for this 
generator set. 
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Catalogue Printing 
 

The print function gives the ability to print a copy of the parts catalogue selected. The 
catalogue will print with a cover page, contents list and index. It is possible to print a 
catalogue for a complete generator set serial number, model number, engine only or 
individual assemblies. 
 
To print a complete generator set parts catalogue by serial number, simply search for the 
serial number in the usual manner as described previously. Once you have found your 
serial number click  “Print….”. 
 

 
 

The system will then ask how you would like to print. The system will tailor the parts catalogue to 

either single-sided or double-sided printing. When double-sided printing is selected the system will 

prepare a parts catalogue that will print in a usable format for viewing. However, the user must 

select double-sided printing in their printer settings also.   
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Compass will then begin compiling the parts catalogue contents lists and indexes for printing. A 

window will appear showing the progress. 

 

 
 

The parts catalogue will then be displayed for previewing. The parts catalogue can be printed by 

clicking the printer button ( ). Alternatively, if the computer has a .pdf file creation software 

installed the catalogue could be printed to a pdf file for storing, emailing or saving to CD. PDF 

creation software is available from the internet, the software will then appear as a print option after 

clicking the printer button ( ). 
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Parts Catalogue 
 

 
Navigation 

 
 

 This section of the software is called the “Catalogue of Parts”. The software is designed to 
display the list of levels for your chosen build list on the left of the screen. An image, if one 
is available, is displayed, and a breakdown of the parts for respective level of the list will 
also be shown.  Clicking on the area highlighted in blue shown below can customise the 
layout of your screen. 

 

 
 
 

 
There are many different buttons and icons displayed within the screen. These are: 
 

 Overview takes you straight to the top of the build list structure. 
 

 Active Arrow up jumps up to the respective higher level of the structure. 
 

 Open or remove the build list structure from the screen. 
 

 Arrangement of the list of parts on the right, next to the drawing, or 
below the drawing. 
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 Fit the drawing to the window width. 
 

 Select a section of the drawing to view in the window. 
 

 Display a pan window to move around the drawing. 
 

 Use the Magnifying glass symbol to zoom in and out of the drawing. 
 

 Additional methods to zoom in and out of the drawing. 
 

 The modules symbol in the list of parts shows that there is a hierarchical 
structure one level down (i.e. a Kit or Assembly). Double-click on that part 
number to drill-down to the next level. Selecting the part will highlight the 
item number on the drawing. 

 
 

 Entries with this Parts symbol represent parts without further hierarchical 
levels. Selecting the part will highlight the item number on the drawing. 

 

 Active item numbers, with a hierarchical structure one level down, in the 
drawing with an equivalent item number in the parts list are highlighted in 
green. 

 

 Active item numbers, without further hierarchical levels, in the drawing 
with an equivalent item number in the parts list are highlighted in yellow. 

 

 Clicking on the part causes the item number in the drawing to be 
highlighted in blue. 

 

 The History icon indicates that the part has a supersession chain that is 
available for viewing. To see the supersession information, double-click 
on the icon. 

 

 The Notes icon appears when a part has a note saved against it. Notes 
can be created in the list of parts, in the drawings and in the 
documentation. (See section on creating notes in Information) 

 

 If a document is available and linked to the parts list then this button, at 
the bottom of the screen, becomes active. It will take you to the 
documentation section of the Information screen. 

 

 If a part is available to order then this button becomes active. It will take 
you to the Shopping Basket section of the application. 

 

 When any additional information is available this button will be active. It 
will take you to the Information screen. 

 Opens an information window in the middle of the screen for either parts 
or data. 
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Additional Information 
 

The Additional Information window is the central point for all information relating to the 
parts in the catalogue. From this window you will find all the General Information (“basic 
data”), Usage (where used), Notes (system and user generated).  

General infos 

 The General Information screen lists any information that might be relevant to the part 
but could not be shown within the parts list of the catalogue. 

 

U 

Usage 

 The Usage section, or Where Used, shows where the part is used in the build list, and if it 
is used in more than one place. 

 

 
Notes 
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Note 

 The Notes section displays all the user notes that have been created. 
 

 
 
 

 From here you can create your own notes and edit or delete those that have already been 
created. To create a new note click on “New”. 
 

 
 
A new window will open on screen. You must give the note a Title and select whether you 
want it to be attached to the Parts list position (attaches the note to this occurrence of 
the part only) or to the Material goods (attaches the note to the part every time it appears 
in the parts book). You can type in your comments into the box at the bottom of the 
window.  You also have the option to send the note to be uploaded (this enables the 
technical authoring team to view it) or to attach a file (e.g. a photo or service report). To 
attach a file click on the “+” and then search for the file you want to select. 
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Once you have selected the file, click on “Open” to add it to your note. To remove the 
attachment click on the “-“. Once you have finished creating your note click on “Save”. 
 
 
 
 

History 

 If a part has supersession information then the history icon will appear in additional 

information.  Also the symbol will appear beside the part as shown below.  The 
information available can then be viewed by clicking on either of these icons. 

 
 

 
 
 
The History section, or Supersessions, displays a list of all parts that have been 
replaced in a chain from the newest to the oldest. This will allow users to check the status 
of a part that a customer may require against what is current and what is in stock. 
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Supersessions 
 
 

 
 
In this case the part searched for was 904-040.  The above image shows us that this part 
was superseded by 922-022. 
 
 
 

 
 
In this case the part searched for was 910-008.  The above image shows us that this part 
supersedes part 983-121.
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Printing 
 
 

You have the option of printing out the currently displayed drawing and/or list of parts. 
Open the drawing and list of parts you require. 
 
In the Menu bar select Print → Current drawing and list of parts or complete module. 
Print the complete module means, that not only is the displayed drawing printed, but also 
all the images for that module and the list of parts. 
 
The Print preview is displayed: 
 

 
 

 Click on the Printer symbol. The Print dialogue window opens and you 
can print out the drawing and list of parts. The drawing and list of parts are 
printed out on the one page. 

 

 Use the Magnifying glass symbol to zoom in and out. 
 

You can page backwards and forwards between the drawing and list of 
parts and go the start/end of the Print preview using the arrow symbols. 

 

 Close takes you back to the Catalogue. 
 

Alternatively, you can print out the parts list by going into the popup Menu and selecting 
Print current parts list. The same applies for the drawing, by clicking on Print current 
drawing (Popup Menu) in the window part of the displayed drawing. 
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Copying 
 

In the window for the drawing use the right mouse button anywhere on the image then 
select copy. The drawing can now be inserted into an application. 
For the parts data use the right mouse button anywhere on the data then select copy. You 
can then select what part of the parts list you wish to copy, cell, line column or all. The list 
of parts can now be inserted into an application (e.g. Excel/Word/etc.). 
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5 
 

Shopping Basket 
 
 
Assigning a Database 
 

When the Shopping Basket is first opened a window will open asking if you want to assign 
a database. 

 

 
 
You must select ‘yes’ to use the shopping basket. A new window will open giving the 
option to create a new database or connect to an existing database. A database can be 
created on each machine or a database can be created on a server. The system has the 
facility for multiple users to connect and share the same database for quotes and orders. If 
you intend to share a single database please note that the system is only designed for 
around 5-10 users to access the database at anyone time. A warning message will be 
displayed if too many users are using the database. Extended configuration will not be 
required by most users. 
 

 
 
Select one of the options and click on ‘Next>’ to continue. 
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Creating a New Database 
 
 

To create a new database you must select a location and name for the file. Click on the 
folder symbol to select the file location. 
 

 
 
Once you have clicked on the file symbol a new window will open where you can make 
your choice for name and location. Select a location and then give the file a name. 
 

 
 
Once you have made you selections click on ‘Save’ to return to the software. 
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You will have returned to the Configuration screen for the software. Click on Finish to 
return to the shopping basket. 
 
Compass will create a new database in your chosen location. If you want to create 
another new database or attach to an existing database you must first delete or move the 
current database. As soon as Compass cannot detect a database it will ask you to create 
a new database. 
 

 
 
The system will now ask you to accept the supplier address from the CD, select ‘Yes’. 
 
 

Using an Existing Database 
 
 

You can use the same process when you want to connect to an existing database. Instead 
of typing a new file name, search for an existing database with the file extension ‘.ppo’ 
Click on ‘Open’ to start using it. This can be a shared database on a server. 
 
If you intend to share a single database please note that the system is only 
designed for around 5-10 users to access the database at anyone time. A warning 
message will be displayed if too many users are using the database at the same 
time. 
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Inputting Pricing 
 
 

To input a new pricing catalogue first press the ‘options’ tab and scroll to import price disk. 
 
 

 
 
 
Now scroll to where the price file is stored and select ‘load prices now’. 
 

 
 
This will import all the prices into your Compass system. 
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Create a new Quote and Basket 
 
 

Once a database has been assigned you can start to create lists of parts in the shopping 
basket. In the parts catalogue select some parts to add to the shopping basket.  
 

 
 
Once you have selected the parts you want click on the ‘Order’ button at the bottom of the 
screen. This will automatically send all the highlighted parts to your shopping basket. 
 
 

 
 
 
Each time you send parts to the shopping basket a message will ask if you want to ‘Create 
a new quote and basket’, or ‘Select an existing basket’. Click one of these to add your 
parts. 



 

Compass User Handbook 
Olympian 

  

27 

 
 

A new parts list has now been created in your shopping basket. You can return to the 
parts catalogue to search for and to add more parts to your basket. If the part has been 
superseded a dialogue box will appear, it will display all the alternatives. Select the correct 
alternative and then click on ‘OK’. 
 

 
 
Once a shopping basket has been created the parts listed in it can be changed at any 
time. Select a part in the basket. This will highlight two buttons on the right of the list, ‘Edit’ 
and ‘Delete’. 
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These buttons allow you to remove any of the parts listed, or change the quantities to be 
ordered for the selected part.  
 

 

Create Settings 
The Compass shopping basket has the option to configure various settings that will be 
used in the quote and order functionality. To view this section select the ‘Settings’ button 
on the left of the screen. 
 

 
 

This will open a new window. 
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Distributor/Dealer 
 

 
To add your company details select the ‘Distributor/Dealer’ tab and select the ‘new’ tab in 
the top right of the window.  The box below will appear. Input your details as required. 
 
 

 
 
 
 
Click ‘OK’ to confirm your selections and press the ‘new’ tab in the bottom right of the 
window.  The following address box will appear. 
 
 

 
 
 
Input the address for your company and click ‘OK’ to confirm your selections. 
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Customer 
To add customer details click on the ‘Customer’ button and then click on the ‘New’ button 
in the top right of the window.  This will open the following box in which customer details 
can be entered. 
 
 

 
 

 
Click on ‘OK’ to finish, and return to the settings window. You have now created a 
customer. Each customer can have multiple address or contacts. Select ‘New’ in the 
address section (bottom right of the window). 
 
 

 
 
 
Type in all of the customer details into the relevant fields, and then click ‘OK’ to continue. 
If you wish to have more than one address for a customer then simply click on ‘new’ in the 
address section and input their alternate address. 
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Addresses can also be imported and exported from the system.  These must be imported 
in text tab delimited format (.txt) and must be in a defined layout.  This can be created in 
Excel and then saved as text tab delimited format.  The format that the columns must be 
in is as follows: 
 
Column A – Customer Number 
Column B – Company 
Column C – Name 
Column D – URL 
Column E – Discount Group 
Column F – Address id 
Column G – Name (Facility name) 
Column H – Contact 
Column I – Street / P.O. box 
Column J – Postal Code/ Zip Code 
Column K – City 
Column L – Country  
Column M – Phone 
Column N – Fax 
Column O – E-mail 
 
An example of this can be shown below. 
 
 
If you wish a customer to have multiple addresses keep columns A-E identical and fill in 
the alternate address in columns F to O. 
 

 
 
 
When you have your Excel file in the correct format choose the ‘File’ tab, click on ‘Save 
as’ and choose to save as file type ‘Text (Tab delimited)’ from the menu.  (You now should 
have a file with the file extension .txt).  In Compass click on the ‘import’ tab and select the 
desired file to load.  The customer details will now be added to the system.  When 
importing data, old data will be overwritten so you may want to export your current list and 
add additional names to this rather than starting from a blank file.  You can export your list 
be selecting the ‘export’ tab and selecting the folder in which you want to save. 
 

 
 
 

Suppliers 
 

The address details for the supplier (i.e. The parts distribution centre in Desford, England) 
will appear automatically so there is no need to add any additional information to this 
screen. 

 

 

 

 

 

 

 



 

Compass User Handbook 
Olympian 

  

32

Additional Charges 
 

To add additional charges click on the ‘Additional charges’ tab and select new.  Then 
simply input any information on charges in with the relevant tax rate. 
 
 

 
 
 

Price Configuration 
 

 
 
 

By selecting the ‘Price Configuration’ tab you can change the way in which price 
information is shown in Compass.  In the ‘General’ tab, under ‘quotation price field’ you 
can select whether to mark-up from the buying price (by selecting ‘DNET Price’), to 
discount away from the recommended retail price (by selecting ‘Retail price’) or to use 
your own prices for the parts by selecting ‘distributor own price’.  In the tab entitled 
‘Account code’ input your account code (e.g. F12345).   This will be used when ordering 
parts.  ‘Address id’ should be left at 01 to get orders sent to your standard address. 
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Open your pricefile in Excel (right click on the file and select open with Excel). The country 
code is a two-digit code shown under country and your currency code is a three-digit code 
shown under currency (this will be used in the ‘base currency’ tab). 
 

 
 
 
 
 
By selecting the ‘Base currency’ your country can be added. Select ‘New’ to add an extra 
country to the list. Selecting the desired country and clicking the ‘Standard’ button can set 
the default country that is used. This must be the same country ID and currency ID 
contained in your pricefile or Compass will not show prices. 
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Selecting the ‘currencies for quotation’ tab allows you to change the currencies that you 
sell to your customers.  You can add any relevant countries along with their currency, 
conversion rate and tax and any text that may be needed.  If you wish a country to have 
multiple currencies add a digit onto the country code e.g. UK would become UK2, UK3 
etc. 
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Discount 
 
By clicking the ‘Discount’ tab various discounts or mark-ups can be set for the selling 
price.  If you have selected ‘DNet price’ in the ‘Price configuration’ tab you can mark 
products up by the percentage entered into the table.  If you have selected ‘RRP price’ in 
the ‘Price configuration’ tab then you can discount away from this price by entering 
negative numbers (e.g. -5, -10 etc.)    You can set various categories of parts to be 
marked up or down by differing percentage to maximise opportunities within the market.  
 

 
 
Across the top of the screen shows the different price bands that you may want to put your 
customers in.  (i.e. you may want to give bigger discounts to some customers than to 
others).  If you would like to create a new band then click on the ‘new’ button.  Type in the 
name of the new price band and it will appear on the screen alongside the other          
price bands. 
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If you wish to save the list you have created select the ‘save’ tab and select a folder to 
save this file to.  This file will save as a text file.  To view the file right click on this file and 
open it with Excel. The following is an example of what it should like. 
 

 
 

The column headings in row 1 are the varying categories for your customers. Column A 
shows the discount code and columns B-D show the varying percentage mark-up/discount 
for each discount code and each customer category.  These percentages can be altered 
and new categories can be added.  When you are happy with the result select ‘file and 
select ‘save as’ and choose to save the file as a text ‘(tab delimited)’ file.  This file can now 
be imported into Compass.   
 
To import a discount file into Compass go to the discount tab and select ‘load’.  Navigate 
to where your file is stored and click ‘OK’.  You will have the option of overwriting the 
current information or adding to it.  
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Selection Lists 
 
From the ‘Selection list’ tab ‘delivery terms’ and ‘transportation description’ can be set.  
Select ‘new’ to add in an extra line of data 
 
 

 
 
 

Export 
 

From this screen you can decide to have exports generated by either ‘text’ or ‘HTML’ by 
selecting the relevant box. 
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By clicking the ‘HTML-Export’ you can set which HTML templates Compass will use for 
quotations and orders.  We supply a template that may be imported to this screen by 
selecting the folder icon beside either the quotation or order fields. The templates are 
stored in your Compass CD under the folder ‘HTML’ which is in the folder ‘Extras’. 
 

Miscellaneous  
 

From this screen a company logo can be added to appear in quotes and exports.  Click on 
the file icon and browse to find the location of the company logo. 
 

 

 
 
Once you have added all the customer details you want then click on ‘Close’ to return to 
the shopping basket. 
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Create a Quote 
 
 

Once you have created a shopping basket you can convert it to a quote for your customer. 
Click on the ‘Create’ button. A drop down box will appear which will display the option to 
‘Quote’. Click on ‘Quote’ to convert the list you have selected. 
 

 
A new window will open in the middle of the screen, which will take you through the step 
for converting a list of parts into a quote. The first page is the Common Settings. 
 

  
 
A quote ID is created automatically. The ‘Created by’ field and ‘Creation date’ are created 
automatically but can be changed. You can also add any comments. Select ‘Next’ to 
continue. 
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The window will change to show the Billing Address section. You can use the drop down 
boxes to select from your list of customers and addresses that you have already created. 
If you have not already created the customer you can create a new customer now by 
selecting “new customer”. 

 
 
If you want to add a different delivery address uncheck the ‘Same delivery address’ box. 
Select save to save the new details. Select next to continue. 
 

 
 
The next screen is the Terms & Comments section. Select the correct delivery terms and 
transportation method using the drop down box or add your own transportation. Type in 
the correct payment terms and named location, if necessary. Select the quote validity 
date. Finally add any additional comments. Select ‘Next’. 
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A list of al the parts in the order, the quantities, and their prices will be brought up.  If you 
are content with the information click ‘next’ to continue. 
 
 
 
 

 
 
Any additional charges that you want to add on may be added on in this section by 
clicking ‘new’.  When you are happy with the information click ‘complete’ to complete the 
order. 
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Create a Order 
 

Orders can also be created by using the ‘create’ tab.  Select ‘create’ and select ‘order’. 
The following screen will appear, if necessary add any required comments. 
 

 
 
Select ‘Next’ and a supplier field should appear.  This should be filled in automatically. 
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Select ‘Next’ and an overview of the parts in your order should appear. Select ‘Save’ when 
you are happy with the information entered. 
 

 

 
 

Print the Quote/Order 
 

Once you have created the information for the quote/order you can send it to be printed as 
a finalised quote/order by selecting the ‘print’ button 
 

 
 
The quote/order appears in a print preview screen. Select the ‘Print’ icon to continue. Click 
on ‘Close’ to return to the shopping basket. You will see that the list of parts that you have 
converted to a quote/order will now have a tick in the box against the quote or order 
column. 
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Export a Quote/Order 
 
 

To export a quote or order, select the ‘Export’ button on the right of the screen. Select 
whether you want to export a quote or an order. A new window will open giving you 
various options for the format you can export the information. 
 

 
 
 
Select whether you want to export in either ‘Text’ format or in ‘HTML’ format, then select 
‘OK’ to continue. 
 

 
 
 
If text is selected the system will create two text files one with the basket information (part 
numbers) and one with the header information (customer details etc.) You can change the 
name of the file and its location if you desire. Select ‘Save’ to continue.  If HTML is 
selected this will save in HTML format using the HTML template which is selected within 
‘settings’.  (Note if you save an order in HTML format this will also export an .egt file, 
which can be loaded to EGO) 
 

 
 

The export has been completed, click on ‘OK’ to finish.  
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Create a Copy 
 
 

To create a copy of an existing basket or quote select the ‘Copy’ button on the right of the 
screen. 
 

 
 

 
A copy will be created in the list of baskets. 
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6 
 

Settings 
 
 
Operator Interface and Data Language 
 
 

You can display the operator interface and the database for the Compass system in any of 
the six languages that are available for selection. Select Options → Language on the 
menu bar, or click on the flag icon at the bottom of the screen. The Language selection 
dialogue window is displayed: 
 

 
 
Select the desired language for the user interface and database and click on OK to 
confirm. The language selected is effective immediately and in future the system will start 
with the language you have selected. 
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7 
 

Reference 
 
 
Menu Bar 
 
 

File → Main Selection 
Opens the window for the Compass search screen.  

 End Program 
Closes the Compass software. 

View→ Catalogue of parts 
Opens the window for the catalogue. 

Order 
Opens the window for ordering. 

Search 
Opens the window for searching. 

Print → Current drawing 
Leads to the Print preview of the drawing for the selected level (module). 
The drawing can be printed out. 

 Current list of parts 
Leads to the Print preview of the list of parts for the selected level 
(module). The list of parts can be printed out. 

 Current drawing and list of parts 
Leads to the print preview of the drawing and list of parts for the selected 
level (module). The drawing and list of parts can be printed out on 
separate pages. 

 Complete module 
Leads to the Print preview of the selected module. The drawings and list 
of parts of the module can be printed out. 

Options → Update 
With the catalogue update the catalogue database is updated. You can 
obtain information on the sequence from the supplier of the CD. 

 Language 
Leads to the dialogue, used to change the language of the user interface, 
documentation and database. 

 E-mail options 
Leads you to the E-mail setup, which you complete before you send your 
orders by E-mail. If necessary, consult your system administrator. 

 Update user settings 
On delivery of a new CD catalogue version this command is selected in 
order to update the addresses and the catalogue. 

 Automatic change to Preview 
If a part on the list of parts is on many of the drawing pages of a module, 
this function is used to mark all the drawings in the postage stamp view, 
on which the part is represented. When displayed the item number is 
highlighted on the respective drawing.  

Display of prices 
Change the currency displayed to enable the quoting of customers in their 
currency. 
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Help → Topics 
Shows you the Online Help for the CD Viewer. 

 

 

Compass Toolbar 
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Serial numbers 
 

 

 
The following are examples of the various serial numbers that can be searched for using 
Compass as discussed in the navigation section. 

 
 
 

Genset Serial  
 
Below we can see an example of a genset serial number (highlighted towards the top of the 
image below) and sales order number (highlighted towards the bottom of the image below).  
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Engine Serial Number 
 

Shown below is an example of an engine serial number: 

 

 
Alternator Serial Number 
 

Shown below (highlighted) is an example of an alternator serial number:  
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8 
 

Glossary 
 
 
In the Catalogue 
 
 

Record A Record is a line in the list of parts, which represents a level (machine, 
module) or a part.  

 
Level A spare parts or service catalogue is usually provided with a hierarchical 

structure. These hierarchical structures are represented in the form of 
nodes or catalogue levels. On entering the catalogue there may be 
different machines/commission numbers, followed by modules, where a 
module is in turn divided into one or more modules.  

 
Catalogue When the term catalogue is used, this always refers to an electronic spare 

parts or service catalogue. 
 
Catalogue Update  

The database of the existing catalogue is updated. 
 
Navigation This is movement through the levels of a catalogue, with the aim of 

viewing it or to find elements of the catalogue. 
 
Note Information in the form of a Note tag can be assigned to any level 

(module) and to any part. 
 
Pan window Display of a portion of an illustration, which can be increased in size to be 

viewed in greater detail.   
 
List of parts Displays the content of an opened level (module), comprising parts and 

other possible levels. 
 
Catalogue of parts  

Is a spare parts or service catalogue displayed on the CD Viewer. It is 
represented as a tree structure and indicates drawings and parts lists for 
the level depicted.  

 
 

 


